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[1] Purpose of this Guide 

The 2014 Regional Meetings Presentation Guide includes navigation tips to help you use the MMIS 

more efficiently and effectively. The Guide also provides step-by-step instructions on querying 

recipient information, including demographics, eligibility and enrollment information. 

[2] MMIS Access & Login 

Access to the MMIS is user-specific and based on the employee’s job duties. Some employees may 

have both update and read access to certain areas of the MMIS, while others have read-only access. 

If you need additional access in the MMIS to perform your job duties, talk with your supervisor or 

manager. For a panel image of the MMIS Logon page, see Figure 1. If you need help logging in to the 

MMIS or have other technical problems, contact the DHS/OHA Service Desk at 1-503-945-5623 or 

email: dhs.servicedesk@state.or.us  

  

Figure 1 – MMIS Logon Page  

 

1. Type your User Name and Password. Your 

User Name always appears in upper case. 

2. Click Login. 

** Three unsuccessful login attempts in a row 

locks you out of the MMIS. Contact the Service 

Desk to get your password reset. 

mailto:dhs.servicedesk@state.or.us
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[3] Introduction: MMIS Navigation Tips  

Sections 4 through 9 of the 2014 Regional Meetings Presentation Guide provide a number of 

navigation tips to help make your work life easier and your use of the MMIS more efficient and 

effective. 

 

[4] MMIS Home Page  

interChange 

At the top of the MMIS Home page is the interChange logo. interChange is the core product produced 

by HP. The MMIS is essentially the same as the interChange application but has been customized to 

meet the needs of the State of Oregon. 

Menu Structure 

The MMIS consists of a Main Menu of subsystems listed horizontally across the top of the page 

beneath the interChange logo. There is a submenu of choices within each subsystem. See Figure 2. 

  

Main Menu 

Select the subsystem from 

the Main Menu, and then 

select the submenu item. 

from the drop-down list.  

Figure 2 - MMIS Home Page  
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When you select a submenu item from one of the subsystems, a second horizontal row of submenu 

choices appears below the Main Menu. These are the same submenu choices you see in the 

subsystem’s drop-down list. See Figure 3. 

 

 

 

 

 

[5] Browser Features to Enhance MMIS Navigation  

The MMIS is a web-based system accessed via a web browser. This document refers to the Internet 

Explorer (IE) web browser. There are a number of browser features to help you navigate the system 

more efficiently. 

Opening Multiple Browser Windows and Tabs 

The MMIS can operate in multiple windows and tabs simultaneously, which gives you the ability to 

display a variety of information while performing a task. For example, you can look up claim 

information while researching a recipient’s eligibility. When you open a new window from the IE File 

menu, the browser will clone the MMIS window currently being displayed and open another MMIS 

session. Each session has its own separate 20-minute timer, but as long as you have at least one 

MMIS window open you are still logged in. See Figures 4 and 5. 

  

Main Menu 

You can also access the submenu items from 

the 2nd row, which appear after you select 

one of the submenu items. 

2nd Row 

Figure 3 – Main Menu and Submenu 
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If you use dual monitors, you can place an MMIS session on each monitor. Or if you use just one 

monitor, you can resize the windows and place them on your single monitor.  

  

To open a second window, select New Window from the 

IE web browser File menu.  

Figure 4 – IE File Menu  

 

If you have dual monitors, drag one 

MMIS session over to your second 

monitor. To close one of the MMIS 

windows, click the X in the upper 

right-hand corner. 

If you have one monitor, you can 

resize and stack your two windows 

on top of one another. To close one 

of the windows, click the X in the 

upper right-hand corner. 

Figure 5 – Multiple MMIS Windows 
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In the IE web browser, you can set up tabs and open multiple web pages within one browser session. 

This can be helpful if you want to navigate to another website, such as the DHS or OHA Home page, 

on a second tab. See Figures 6 and 7. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Figure 7 example, there are two tabs in one browser session. The first tab is the MMIS session 

(Recipient Case Search) and the second tab is the DHS Staff Tools website.  

  

1. To open a second tab, select New Tab from the 

web browser’s File menu. 

Figure 6 – Open New Tab 

 

2. To open your Home page, click on the web 

browser’s Home       icon.  

This action takes you to whatever web page is set up 

as your Home page. To close the tab, click on the X in 

the upper right-hand corner of the tab. 

1st Tab 

 

2nd 

Tab 

 

Figure 7 – Multiple Tabs & Home Icon 
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Printing 

There’s more than one way to print from the MMIS, including clicking the IE browser’s printer icon or 

pressing Control P on your keyboard. You can also print from the browser’s File menu by selecting File 

> Print. See Figure 8. 

 

 

 

 

Copying & Pasting 

You can use the Copy and Paste feature in the IE web browser to copy and paste information from 

within the MMIS or from a source system into the MMIS. See Figure 9. For example, you might copy a 

prime number from your source system and paste it into the Current ID field when you do a Recipient 

Search.  

 
 
 

Changing Text Size 

You can change the size of the text on a page from the View menu in your web browser. See Figure 

10. If you increase the text size, it might be easier to read, but you’ll probably have to scroll back and 

forth across the page more often.  

  

Select Print from the web browser’s File menu to 

print from the MMIS (for example, Temporary ID 

cards).  

Figure 8 – IE Print Command  

 

Figure 9 – IE Copy and Paste Commands  

 

Select Copy from the web browser’s Edit 

menu to copy information and select 

Paste to paste information. 
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Another way to change the text size is to hold down the Control key on your keyboard while at the 

same time scroll your mouse wheel up and down.  

 
 
 
 
 
 
 
 
 
 
 
 

The Back Button 

It is important to avoid using the browser’s Back button while working in the MMIS. 

Normally when you click the Back button while viewing web pages, the web browser 

returns you to a previously viewed page that is displayed exactly the same as when you left 

it. The Back button has been disabled in the MMIS. The system handles information in real 

time and clicking the Back button could return you to a page that is displaying outdated data. If you 

inadvertently click the Back button, the system may log you out, but you can simply log in again.  

The Home Button 

The Home button takes you to the web page you have set up as your Home page. If you click 

the Home button while in the MMIS, you will be logged out of the system and taken directly 

to your Home page. If you’d like to access your Home page while continuing to work in the MMIS, 

select New Tab or New Window from the browser’s File menu, and then click the Home button. 

 

 

  
Figure 11 – IE Back and Home Buttons 

 

Back 

Home 

Select Text Size from the web 

browser’s View menu to change 

the text size. Then select one of the 

choices in the drop-down menu 

(Larger, Smaller, etc.). 

Figure 10 – IE View Menu  
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[6] Help Menus  

The Help menu can be found on the MMIS main menu at the top of the page. Two types of help are 

available from the main menu: User Manuals and Topic Search.  

User Manuals 

The User Manuals in the Help menu is organized by subsystem and the subsystems are divided into 

sections: Introduction, Panels, and Reports. The Introduction section provides basic information 

about the subsystem. The Panels section includes a list of all panels in a subsystem, and each one is a 

hyperlink that opens a help topic. The Reports section lists reports available in that subsystem, and 

each item in the list is a hyperlink to more details. Figures 12 through 14 describe how to look up 

User Manuals information for Recipient Data Maintenance. Figure 15 is an example of Online Panel 

Help for the Recipient Search Criteria panel.  

 

  

1. Select User Manuals from 

the Help menu. 

Figure 12 – MMIS Help Menu 

Menu  

Buttons 

 

2. Select Recipient Panels under Recipient Data 

Maintenance.  

This action takes you to a list of all the panels in the 

Recipient Data Maintenance subsystem. 

Figure 13 – MMIS User Manuals  

Buttons 
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.  

Figure 14 – Help Topic Hyperlinks 

Buttons 

 

3. Select Recipient Search Criteria. 

The Online Panel Help topic will open in a 

separate window. See Figure 15. 

Description of the panel and steps to take to find the 

Recipient Search Criteria panel from the MMIS main menu 

 

Image of the panel 

Details about the fields on the Recipient 

Search Criteria panel 

“Error” messages you’ll see when entering data or 

saving a record when there is incomplete 

information or data entered in an incorrect format 

Figure 15 – Online Panel Help 

Topic 

Buttons 
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Topic Search 

In the Topic Search submenu under Help, you can search for a keyword or keywords that are part of a 

panel name or panel description. The Topic Search can be helpful if you are not sure which subsystem 

contains the information you’re seeking. For example, if you’re not sure how to do a Recipient 

Search, you can search by the keywords “recipient search” and then view a list of all panels in the 

MMIS with the words “recipient search” in the panel name or panel description. See Figures 16 

through 18 describing how to do a Topic Search for the keywords: “recipient search.” 

 

  

2. Type recipient search in the Keyword field, and then click 

the Search button.  

The Keyword search is NOT case sensitive, but it is spelling 

sensitive. The system will look for exactly what you type. 

Figure 17 – Keyword Search 

1. Select Topic Search 

from the Help menu. 

.menu. 

Figure 16 – Topic Search Submenu Item 
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  3. Select one of the panel rows in the Search Results. The 

Online Panel Help topic will open in a separate window for 

the row you chose.  

The Search Results display two rows of information that contain 

panels in the MMIS with the keywords “recipient search” in the 

panel name or panel description.  

4. To close the Online Panel Help 

topic, click the X in the upper 

right-hand corner of the window. 

Figure 18 – Keyword Search Results 
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[7] Common Types of Panels 

The Search Panel 

Most subsystems in the MMIS contain a Search panel where you can input specific search criteria to 

locate information. See Figure 19 showing an example of the Search panel from the Recipient 

subsystem. You can search by the client’s Current ID (Prime Number) if you have it. Or you can enter 

other search criteria, such as Last Name, First Name, and Birth Date. You will not see the words 

“Prime Number” in any of the MMIS fields. The MMIS refers to Prime Number as Current ID, Client ID, 

or Recipient ID. There is also a “Sounds-like” feature in the Recipient Search panel where you can 

search for a recipient whose name sounds similar to what you type in the Last Name field. Once 

you’ve entered the search criteria, click the Search button to see the results. If the system cannot find 

any information based on your search criteria, you’ll see “No rows found” in the Search Results. If the 

system finds one record based on your search criteria, then that record will open. If the system finds 

multiple rows of information, those rows will display in the search results.  

 

 

 

 

 

 

 

  

Search by the Current ID or enter other 

search criteria, such as Last Name, First 

Name, and Birth Date. 

Check the “Sounds-like” 

box if you want to search 

for records with a last name 

that sounds like what you 

typed. 

Figure 19 – MMIS Search Panel 
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The Mini Search Panel 

A mini search panel appears at the top of most records, such as the Recipient Information record. 

Type the ID (Current ID or Case ID) in the corresponding field to do a quick search. See Figure 20. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Information Panel 

The Information panel shown in Figure 21 displays recipient information.  

 

  

Figure 21 – Information Panel 

This is the name of the 

information panel. 

This column displays the 

recipient’s eligibility 

information. To see items in 

the drop-down lists, click the 

arrow at the end of the field. 

These columns display the 

recipient’s demographic 

information. 

Mini Search panel. To use the mini 

search panel, type the ID in the 

appropriate field, and then click search. 

Figure 20 – Mini Search Panel 
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The Maintenance Panel 

Most MMIS records contain a Maintenance panel that is used to retrieve more detailed information 

contained in the record.   

 

 

 

 

 

 

The Maintenance panel is organized into groups of information in the left pane with a corresponding 

list of panels available within each group in the right pane. Each panel title is a hyperlink that opens 

the corresponding panel so you can view the data contained in it. When you select a panel hyperlink, 

the panel loads below all the panels already open. The Base Information panel loads automatically 

when you choose any of the panels. The Save and Cancel buttons can be found only on the 

Maintenance panels. See Figure 22. 

Panel Components: Columns, Fields, and Rows 

Each panel within a record can include a combination of columns, fields, and rows. See Figure 23. 

Each row is a hyperlink to additional information. When selecting a row, either a separate window 

will open or nearby fields will populate with information associated with the row you selected.  

 
  Columns 

Click on the column title to 

sort the column. 

 

Fields 

Rows 

Figure 23 – Columns, Fields, and Rows 

Each panel title is a hyperlink 

to more information.  

Each panel you select loads beneath any 

other panels you have open. 

Groups 

The Save and Cancel buttons live 

only in the Maintenance panel. 

Figure 22 – Maintenance Panel 
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Panel Navigation Buttons  

There are navigation buttons in the upper right-hand corner of each panel and each button performs 

a different action. See Figures 24 and 25.  

  

Figure 25 – Panel Navigation Buttons 

Figure 24 – Panel Navigation 

Panel navigation buttons 
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Field and Panel Help 

In addition to the help available from the MMIS main menu, you can also access help directly from 

the panels. A question mark (?) appears when you hover the cursor over any field title. When you 

click on the field title, a description is displayed with more details. When you click on a question mark 

in the upper right-hand corner of a panel, a separate window opens to the Online Panel Help topic for 

that specific panel. See Figure 26. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[8] Setting Preferences 

All Maintenance panels have a “Preferences” feature that allows you to customize which panels open 

automatically whenever you access a record. For example, you may routinely look up Benefit Plan 

details and print Temporary ID cards. You can set up your Preferences to automatically open those 

panels every time you look up a recipient record. The following example shows how to set 

Preferences so that the Benefit Plan and Temp ID Card panels open automatically each time you 

access a recipient record. See Figure 27.  

  

Figure 26 – Field and Panel Help 

Field Help 

Online Panel Help 
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1. Click the Prefs button in the 

upper right-hand corner of the 

Maintenance panel. 

Figure 27 – Setting Preferences 

1. Click the Prefs button in the upper right-

hand corner of the Maintenance panel. 

2. Select the checkbox next to each panel that 

you want opened automatically.  

3. Click the Prefs button again to 

restore the hyperlink view.  

The next time you access a recipient record, the Benefit Plan 

and Temp ID Card panels will open automatically.  

The Base Information panel opens by default regardless of 

how you set your preferences. 



 

2014 Regional Meetings Presentation Guide 

Page 21 of 46 

HP Confidential Copyright © 2011, Hewlett Packard Corporation. All rights reserved. 

[9] Additional Navigation Tips  

Right-Click and Open a New Tab or Window 

From the MMIS main menu, you can right click on any of the submenu items and select “Open in New 

Tab” or “Open in New Window” to access a specific submenu item without closing your first window. 

This can be helpful if, for example, you want to keep a recipient record open in one window or tab 

and search for information in the TPL subsystem in a second window or tab. Once you’ve performed 

the right-click “Open in New Window” or “Open in New Tab”, you can keep two MMIS pages open. If 

you have dual monitors, you can place one MMIS window on each monitor. If you have just one 

monitor, you can open one MMIS page on each tab, or stack two windows on a single monitor. See 

Figures 28 through 30. 

  

Hover your cursor over the submenu 

item you wish to open, and right click. 

Then select Open in New Tab or Open 

in New Window.  

Figure 28 – Open a New Tab or Window 
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If you right click and Open in New Tab, you’ll see 

two tabs at the top of the web browser. You can 

then alternate between tabs and work in two 

areas of the MMIS. 

Figure 29 – Multiple MMIS Tabs 

If you right click and Open in New 

Window, you can place both windows 

on a single monitor. Or if you have dual 

monitors, you can place one window on 

each monitor. 

Figure 30 – Multiple MMIS Windows 
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Activate Row Selection Links 

The Activate Row Selection Links setting, sometimes called the “eyeglass” feature, replaces the row’s 

hyperlink with an eyeglass icon next to each row. If you want to copy information from a row, such as 

an invoice number or ICN, you can’t do that when the row itself is a hyperlink. When you turn on the 

Activate Row Selection Links setting, the eyeglass icon becomes the hyperlink and you can then copy 

information from the row. You might use this feature when reviewing a list of ICNs in the Claims 

subsystem. For example, you could turn on Activate Row Selection Links, open a list of claims in one 

MMIS window or tab, and then copy/paste the ICN number in a second MMIS window or tab to 

review that specific claim. You can then alternate between windows or tabs and look up multiple 

ICNs. Figures 31 through 35 describe how to set up the Activate Row Selection Links feature and use 

it to look up multiple ICNs in the Claims subsystem.  

  

1. Select Personal Settings from 

the Site submenu. 

2. Select the checkbox next to 

Activate Row Selection Links. 

Then click the Update button. 

Figure 31 – Setting the Activate Row Selection Links 



 

2014 Regional Meetings Presentation Guide 

Page 24 of 46 

HP Confidential Copyright © 2011, Hewlett Packard Corporation. All rights reserved. 

 
  

3. Go to the Claims subsystem and 

select Search. 

4. Enter the search criteria 

and click Search. 

 

See the eyeglass icon next to each row in your Search Results 

and notice how the ICN number is no longer a hyperlink.  

5. Copy one of the ICNs from the list. 

6. Right click on Search on the Claims submenu and 

select Open in New Tab or Open in New 

Window. This action loads the Claim Search 

panel. See top of Figure 33. 

If you have dual monitors, it works well to Open in 

New Window. If you have a single monitor, it works 

well to Open in New Tab. 

Figure 32 – Using Activate Row Selection Links 
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7. Paste the ICN in the ICN field and 

click Search. 

You’ll see claims information for that 

ICN. See example below. 

7. Paste the ICN in the ICN field and click 

search. 

You’ll see claims information for that ICN. 

See example below. 

You can now alternate between the two windows or 

two tabs and review multiple claims by copying and 

pasting the ICNs. See Figures 34 and 35. 

Figure 33 – Using Activate Row Selection Links 

Figure 34 – Alternating Between Two Tabs 

If you opened two tabs, you can 

alternate between them.  
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If you opened two MMIS 

windows, you can stack both 

windows on a single monitor. 

You can place one MMIS window on 

one monitor and one window on the 

other monitor. OR 

Figure 35 – Viewing Options for Two Windows 



 

2014 Regional Meetings Presentation Guide 

Page 27 of 46 

HP Confidential Copyright © 2011, Hewlett Packard Corporation. All rights reserved. 

[10] Introduction: Recipient Data Inquiry 

Sections 11 through 15 of the 2014 Regional Meetings Presentation Guide provide step-by-step 

instructions on how to query recipient information, including recipient demographics, recipient 

benefit plans and managed care/coordinated care enrollment, TPL, and managed care exemptions.  

[11] MMIS as the Final Authority 

The MMIS should always be considered the final authority when verifying any aspect of a recipient’s 

Medicaid coverage. A number of systems interface with the MMIS and provide data updates. These 

updates can occur in real time or in overnight batch processes. The MMIS also receives information 

periodically, such as during daily, weekly, semi-monthly, or monthly processes. However, it is the 

current information in the MMIS that is used to verify everything related to a recipient’s Medicaid 

coverage. For example, providers verify a recipient’s eligibility through the Provider Web Portal and 

the Automated Voice Response (AVR) system. Both of these systems access the most recent eligibility 

information directly from the MMIS. Claims are also processed using the recipient’s most recent 

eligibility and enrollment information available in the MMIS. So it is important to always look to the 

MMIS when verifying a recipient’s benefit plan, coordinated care or managed care enrollment, TPL, 

managed care exemption, or any other aspect of the recipient’s Medicaid coverage.  
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[12] Recipient Record 

A number of new fields have been added to the Recipient Information panel and most are self-

explanatory. There are, however, two new fields that require some explanation and those are 

described in Figure 1, which was taken from the Production MMIS (no PHI). All other Recipient 

Information panel images in this document have been copied from the MMIS Training environment 

and do not display all the new fields. 

 

  

The Renewal Date field 

indicates the date the 

recipient’s recertification 

is due.  

The TBQ Record field indicates the status of the 

recipient’s TBQ Record. TBQ (Territory Beneficiary 

Query) is the process by which data is exchanged 

between the MMIS and CMS for recipients with 

Medicare. Status categories include NA, Pending, 

Mismatch, and Applied. 

Figure 1 - TBQ and Renewal Date Fields 
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Recipient information can be found in the Recipient subsystem and includes information about a 

recipient’s demographics, eligibility, and enrollment.  

Figures 2 through 5 describe how to search for a Recipient and view the record. 

 

  

1. Select Search from the 

Recipient subsystem. 

Figure 2 - Recipient Search 

2. Enter search criteria. 

3. Click search. 

Figure 3 - Recipient Search Panel 
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Recipient Demographic Information 

  

Figure 5 - Recipient Information Panel (2) 

The recipient’s eligibility and enrollment 

information is displayed in the right-hand column 

of the Recipient Information panel.  

Important: Do not use the TPL or TPL Good Cause 

fields in this panel to verify a recipient’s TPL or 

Good Cause status. Always view this information in 

the TPL subsystem for the recipient’s most recent 

TPL information available in the MMIS. See more 

details starting on page 42. 

Figure 4 - Recipient Information Panel 

The recipient’s demographic 

information is displayed in the 

left-hand columns of the 

Recipient Information panel. 

The HNA Indicator field indicates 

if the recipient has Native 

American or Alaska Native status.  
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Recipient Eligibility and Enrollment Information 

 
Benefit Plan: Indicates the recipient’s current and former Benefit Plans and dates of enrollment. A 

date range ending in 12/31/2299 (the MMIS infinity date) indicates the recipient’s current 

enrollment.  

Medicare Coverage: Indicates whether or not the recipient is covered under Medicare A, B, and D. If 

the recipient has Part C coverage, there is no Part C flag in this field. However, you will find Part C 

information in the same panels as Part D. 

Managed Care: Indicates the recipient’s current and former enrollment in a Managed Care or 

Coordinated Care Plan, and displays the dates of enrollment.  

TPL (Third Party Liability): This field may not reflect the most recent information about a recipient’s 

TPL coverage. For the most recent information available in the MMIS about a recipient’s TPL, always 

view the recipient’s TPL record in the TPL subsystem. See more details starting on page 42. 

Good Cause: This field may not reflect the most recent information about a recipient’s Good Cause 

status. For the most recent information available to the MMIS about a recipient’s Good Cause status, 

always view the recipient’s TPL record in the TPL subsystem. See more details starting on page 42.   

Level of Care & Patient Liability: Refers to patient care in a nursing facility. These fields indicate the 

Level of Care and whether the recipient has Patient Liability entered on their record. 

Medicare Buy-In: Indicates if a recipient with Medicare coverage participates in a Medicare Buy-In 

Program. 

Case/Certification: Displays the recipient’s case number and their most recent eligibility date in that 

case. If the recipient is currently in or has been in more than one case, then multiple rows display. 

The last three letters of the case number is the agency code and indicates the agency where the 

recipient’s eligibility was determined (example: ED28610SSD). See the following list of agency codes: 
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Agency Codes 

AFS – Adult and Family Services 

CSD  – Children’s Services Division 

FST   – SNAP 

HIX   – Health Insurance Exchange/Cover Oregon 

MHA  – Mental Health Agency 

OHA  – Oregon Health Authority 

OYA  – Oregon Youth Authority 

SSD  – Senior Services Division 

 

Medical Case Management - Disease Case Management: Indicates whether the recipient is enrolled 

in a case management program for individuals with certain chronic conditions, such as asthma or 

diabetes. 

Premium Arrearage: Indicates whether the recipient is in arrears on their OHP Premium payments.  

NF/Hospice Restrict: Indicates if the recipient is receiving hospice care while residing in a nursing 

facility.  
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[13] Benefit Plan and Case Information 

Information about the recipient’s current and former benefit plans can be found on the Benefit Plan 

panel in the Recipient subsystem. See Figures 6 through 9. 

 

The Benefit Plan panel displays the recipient’s current and former Benefit Plan enrollments.  

 

 

  

Figure 6 – Maintenance Panel  

1. Select the Recipient group on the 

Recipient Maintenance panel. 

2. Click the Benefit 

Plan hyperlink. 

Figure 7 - Benefit Plan Panel 

3. Select any of the Benefit Plan 

line items to view additional 

information. 
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Benefit Plan Details 

The Benefit Plan panel displays information that provides more details about the recipient’s Benefit 

Plan enrollment. See Figure 8. The Benefit Plan column displays the names of the recipient’s Benefit 

Plans. The Status column indicates if the Benefit Plan is in an Active (valid) status or History (invalid) 

status during the date segments listed in the Effective Date and End Date columns. The Effective Date 

and End Date columns display the dates that enrollment in each plan became effective and the dates 

each plan ended or will end. 

 

  

Figure 8 - Benefit Plan Columns 
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Aid Category and Case Descriptors Data 

The Benefit Plan panel also displays the recipient’s Aid Category and Case Descriptors Data for each 

benefit plan. Figure 9 describes how to view the Aid Category and Case Descriptors Data. 

 

The Mailing Address Data shown on the Benefit Plan panel displays the address that is used for all 

recipient mailings. See Figure 10. The Residential Zip and Residential County codes are used to 

determine a recipient’s Coordinated Care or Managed Care enrollment. If the recipient’s residential 

address is different from the mailing address, then the Residential Address Data will display a 

different address.  

  

Figure 9 - Aid Category & Case Descriptors Data 

1. On the Benefit Plan 

panel, select the line 

item for the Aid 

Category Data you wish 

to view.  

The Aid Category Data 

populates. 

2. Select a line item in the Aid 

Category Data section of the 

panel to view the Case 

Descriptors Data. 
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Case Information 

To find the names of all members who are part of the same case, you can perform a Case Search from 

the Recipient subsystem. See Figures 11 through 13. 

 
 

 
 
 
  

1. From the Recipient 

subsystem, select Case 

Search. 

Figure 11 - Recipient Case Search 

Figure 10 - Mailing Address Data 
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5. Select Case Members on the Case Maintenance panel. A list of all 

case members for this case will display in the Case Members panel.  

6. To view the recipient’s record in a 

separate window, select the recipient’s 

ID number under the Current ID 

column. 

7. To view additional case information, 

select a row in the Case Members 

panel. This action populates the fields 

and removes the Current ID hyperlinks.  

To get the Current ID hyperlinks to reappear, 

click on the Current ID column heading. 
 Figure 13 - Case Members Panel 

  Figure 12 - Case Search Results 

2. Enter search criteria.  

This example shows a 

search by Current ID. 

3.  Click search. 

4. From the Search Results, select 

the active case. 

If the recipient is in only one case, 

then the system will not display 

Search Results and will take you 

directly to the recipient’s case record.  
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[14] Coordinated Care and Managed Care Enrollment 

Transitioning to Coordinated Care 

The State of Oregon began transitioning from Managed Care Organizations (MCOs) to Coordinated 

Care Organizations (CCOs) in August of 2012 as part of an overall effort to improve health care for all 

Oregonians. At that time, the MMIS began displaying both MCO and CCO enrollment information for 

recipients. Throughout this guide, there are references to both Coordinated Care and Managed Care 

enrollment for OHP (Medicaid) clients. The goal of the CCO transition is to move all Managed Care 

Organizations into a Coordinated Care Organization over time. However, even after this CCO 

transition is complete, you will still see MCO enrollment data in the MMIS because the system 

maintains a history of each recipient’s current and former MCO and CCO enrollment.  

Recipient Case Enrollment 

 

  

1. Select Managed Care from 

the Managed Care 

subsystem. 

 Figure 14 - Managed Care Subsystem 
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Information about a recipient’s current and former Coordinated Care or Managed Care enrollment 

can be found in the Managed Care subsystem. You can also view a list of Managed Care and 

Coordinated Care Organizations available to the recipient in their geographic region based on their 

address of residence. Figures 14 - 18 describe how to view the recipient’s enrollment information. 

 

A list of the recipient’s current and former Coordinated Care and Managed Care enrollments is 

displayed in the Enrollments panel. 

 

  

4. Select any of the line items on 

the Enrollments panel to view 

additional information. 

 Figure 16 - Enrollments Panel 

2. Select Recipient Case 

Enrollment from the 

maintenance panel. 

3. Enter the Recipient ID or 

Case Number and click 

search. 

Figure 15 - Recipient Case Enrollment Search 
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Enrollments Details 

The Enrollments panel displays information that provides additional details about a recipient’s 

current and former Coordinated Care and Managed Care enrollments. See Figure 17. 

 

 

The Status column indicates if the Enrollment is in an Active (valid) status or History (invalid) status 

during the date segments listed in the Effective Date and End Date columns. The MC Program column 

displays the type of Coordinated Care or Managed Care Organization. The Effective Date and End 

Date columns display the dates that enrollment in each plan became effective and the dates each 

plan ended or will end. The MC Region column displays the region code and name of the Coordinated 

Care or Managed Care plan. The Enrollment column indicates whether or not that specific 

Coordinated Care or Managed Care plan is open for new enrollment.  

 
The PCM/MCO section of the Recipient Case Enrollment panel displays all the Coordinated Care and 

Managed Care plans available in the recipient’s geographic region based on the recipient’s address of 

residence (FIPS/ZIP). See Figure 18.  

  

Figure 17 - Enrollments Panel Columns 



 

2014 Regional Meetings Presentation Guide 

Page 41 of 46 

HP Confidential Copyright © 2011, Hewlett Packard Corporation. All rights reserved. 

 

Managed Care Exemptions 

A Managed Care Exemption is placed on a recipient’s record to prevent auto-enrollment into a 

Coordinated Care or Managed Care plan. Managed Care Exemption information can be found in the 

Recipient subsystem and is titled MC Special Conditions. Figures 19 and 20 describe how to look up a 

recipient’s Managed Care Exemption. 

 

  

Figure 18 - PCM/MCO Panel 

1. Select MC Special Conditions on 

the Recipient Maintenance panel. 

Figure 19 – MC Special Conditions Panel 
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The example below displays a Managed Care Exemption with three separate MC Special Condition 

codes, one for FCHP, PCO, and CCOB. These three codes ensure that the recipient will not be auto-

enrolled into any physical health plan, including Kaiser (the only PCO). You may see additional CCO 

Special Condition codes to prevent auto-enrollment into other CCOs that cover physical health. 

 

[15] Third Party Liability (TPL) 

A recipient’s third party insurance information can be found in the TPL subsystem, including policy 

details, coverage information, and a list of dependents covered on each policy. You can also 

determine whether Good Cause has been applied to the recipient’s third party insurance. Figures 21 

through 28 describe how to view TPL information. 

  

The recipient’s exemption is displayed 

on the MC Special Conditions panel. 

2. Select one of the line items to 

populate the fields. 

Figure 20 – MC Special Conditions Panel (2) 
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1. Select Search from the 

TPL subsystem. 

Figure 23 - TPL Subsystem 

The TPL Information panel for 

that policy and the Maintenance 

panel will display.  

Figure 21 - TPL Information & Maintenance Panels 

2. Enter the Current ID and click search. 

The Search Results will display the recipient’s 

TPL policies. If there is only one TPL policy, 

the system will automatically display the TPL 

Information panel for the recipient’s TPL 

record. See Figure 23. 

3. Select the line item for the 

policy you wish to view. 

 

Figure 22 - TPL Search 
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The Base Information panel loads automatically when you select any panel from the TPL Maintenance 

panel. If Good Cause has been applied to the recipient’s third party insurance, the Cost Avoidance, 

Suspect Code, and Policy Type fields display as indicated in Figure 25. 

  

Figure 24 - TPL Maintenance Panel 

4. To view additional details about the 

recipient’s TPL, select panels such as 

Additional Policies, Coverage, and 

Dependents of Policy from the TPL 

Maintenance panel.  

Figure 25 - Base Information Panel and Good Cause 
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The Coverage panel displays details for the policy. The Dependents of Policy panel displays a list of all 

dependents covered by the policy. The Additional Policies panel displays a list of the recipient’s other 

TPL policies if there is more than one. See Figures 26 through 28.  

 

  

Figure 27 - TPL Dependents of Policy 

Figure 28 - TPL Additional Policies Panel 

6. Select the line item to view additional policy 

information. 

A separate window will open displaying 

information for that policy. To close the window, 

click the X in the upper right-hand corner of the 

window. 

Figure 26 - Coverage Panel 

5. Select the line item to view 

coverage details for the policy. 
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[16] Additional Resources & Contact Information 

Do you have MMIS training-related questions? Contact Robert Costa, MMIS Training Manager, OHA, 

at robert.m.costa@state.or.us 

Do you want to sign up for MMIS training? Go to the DHS/OHA Learning Center at the following link: 

https://dhslearn.hr.state.or.us  If you cannot find the training you’re looking for, contact Robert 

Costa. 

Does your department need customized MMIS training, or would you like to schedule a one-on-one 

tutorial? Contact Robert Costa. 

Are you experiencing technical issues with the MMIS, such as not being able to log in? Contact the 

DHS/OHA Service Desk at 1-503-945-5623 or dhs.servicedesk@state.or.us  

 

mailto:robert.m.costa@state.or.us
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